Sponsorships and Events

Sponsorship rates, events calendar and event descriptions for 2017

Events calendar ................................................................. 3
Business Person of the Year ............................................ 4
SPACE Awards ................................................................. 5
Corporate Citizenship Awards ........................................... 6
Healthcare Heroes Awards ............................................... 7
Mentoring Monday ........................................................... 8
Women in Business .......................................................... 9
Residential Real Estate Awards ....................................... 10
Life Sciences Awards ...................................................... 11
CEO of the Year Awards .................................................. 12
40 Under 40 Awards ....................................................... 13
CFO of the Year Awards .................................................. 14
Tomorrow’s Real Estate ................................................... 15
C-Suite Awards ............................................................... 16
Leaders in Diversity ....................................................... 17
Best Places to Work ......................................................... 18
Healthiest Employers of the Triangle ............................... 19
Fast 50 Awards ............................................................... 20
Family Business Awards ............................................... 21
Power Breakfast ............................................................. 22
On the Road with TBJ ..................................................... 23
Title Sponsorship ........................................................... 25
Presenting Sponsorship .................................................. 26
Corporate Sponsorship .................................................. 27
Welcome/Afterglow Sponsorship .................................... 28
Tweetwall Sponsorship ................................................... 19
Photobooth Sponsorship ............................................... 30
Valet and Parking Sponsorship ....................................... 31
Power Breakfast Sponsorship ........................................ 32
Table of Experts/Live Panel or Roundtable ....................... 33
Contact us ........................................................................ 34

Questions? Contact nboetcher@bizjournals.com
Be a part of our 2017 events as a sponsor.
## 2017 Events Calendar

Find more information at [TBJevents.com](http://TBJevents.com)

### JANUARY
- **Business Person of the Year**
  - Lunch
- **SPACE Awards**
  - Dinner

### FEBRUARY
- **On the Road with TBJ**
  - Breakfast
- **Power Breakfast**
  - Breakfast

### MARCH
- **Corporate Citizenship Awards**
  - Dinner
- **Healthcare Heroes**
  - Dinner
- **On the Road with TBJ**
  - Breakfast

### APRIL
- **Mentoring Monday**
  - Breakfast
- **Women in Business Awards**
  - Lunch
- **Residential Real Estate Awards**
  - Lunch

### MAY
- **Life Sciences Awards**
  - Lunch
- **CEO of the Year Awards**
  - Dinner

### JUNE
- **Power Breakfast**
  - Breakfast
- **40 Under 40 Awards**
  - Lunch

### JULY
- **CFO of the Year Awards**
  - Lunch
- **Tomorrow’s Real Estate**
  - Breakfast

### AUGUST
- **C-Suite Awards**
  - Lunch
- **Power Breakfast**
  - Breakfast

### SEPTEMBER
- **On the Road with TBJ**
  - Breakfast
- **Leaders in Diversity Awards**
  - Lunch
- **Best Places to Work Awards**
  - Lunch

### OCTOBER
- **Healthiest Employers Awards**
  - Lunch

### NOVEMBER
- **Fast 50 Awards**
  - Dinner
- **Power Breakfast**
  - Breakfast

### DECEMBER
- **Family Business Awards**
  - Dinner

---

**HELPFUL HINT**
Registration for each event opens at least 6 weeks prior and closes 1 week before the event. [TriangleBusinessJournal.com/event](http://TriangleBusinessJournal.com/event)

**NOMINATE SOMEONE**
Submit a nomination for one of our 2017 programs at [TBJnominations.com](http://TBJnominations.com)
Business Person of the Year

Our Business Person of the Year Award recognizes business and community achievement of the highest level.

This is the 13th annual award year. The winner will be profiled in the last issue of December 2016.

Criteria for selection include financial performance, personal qualities, managerial skills and contribution to making the Triangle a stronger city.

**Event Format**
- Heavy hors d’oeuvres and open bar

**Audience Profile**
Business Professionals who are looking to honor and thank the Business Person of the Year. Attendance between 75 and 100.

Previous winners have been:
- Scott Custer (2005)
- Jim Rutherford (2006)
- Dennis Gillings (2007)
- Victoria Haynes (2008)
- Frank Holding (2009)
- John Brantley (2010)
- Jim Whitehurst (2011)
- Adam Abram (2012)
- Jim Whitehurst (2013)
- Scott Wingo (2014)
- Ashley Christensen (2015)
- John Kane (2016)

**Event Date**: Week of January 20th
SPACE Awards

A Triangle tradition for years, the SPACE Awards is intentionally held in January every year to gather the leadership in the commercial real estate sector to look forward to new opportunities for growth together while celebrating individual successes from the year before.

Event Format
- Dinner and awards presentation
- Event experience includes video presentation, customized music and lively drawings & giveaways.

Audience Profile
Triangle SPACE Awards typically draws between 250-300 guests. Attendance is composed of winners and their guests; vertical vendor groups interested in networking with winners (such as subcontractors, contractors, architects and the financial sector).

Event Date: Week of January 27th
Corporate Citizenship Awards

Triangle Business Journal’s inaugural Corporate Citizenship Awards will feature a keynote address and awards dinner honoring organizations who have made exceptional philanthropic contributions to the Triangle in the past year. We will also be introducing our Triangle Giving Guide website that helps to provide a full network of local nonprofits. Along with the awards there will be a nonprofit expo highlighting all of the Triangle’s philanthropy companies.

**Event Format**

» Dinner and awards presentation
» Philanthropy expo

**Audience Profile**

For this first year event our goal is to get 80 to 100 nonprofit businesses in the Triangle for the expo and 150 to 200 companies in attendance.

---

**Event Date:** Week of March 3rd
Healthcare Heroes Awards

Whether it’s a nurse going above and beyond the call of duty with a child in the pediatric unit or an off-duty doctor who saves the life of a lacrosse player, it is the stories behind the heroes that makes this Triangle Business Journal event so memorable. Healthcare Heroes lifts up examples of people taking care of others in dramatic and emotional ways, all told by the people who nominated them in the first place.

**Event Format**
- Evening dinner.
- Networking showcase before dinner.
- Storytelling through video and live narrative.

**Audience Profile**
Between 200 – 250 attendees, including leading caregivers across specialty lines and institutions, administrative leaders from across the healthcare spectrum as well as dentists and allied health professionals are represented in both the nominating categories and the audience.

**Event Date:** Week of March 17th
Meet your Mentor. Join us for this one-of-a-kind event that brings together women in a casual, fast-paced coaching atmosphere. Forty of the most influential women in the community will sit down with attendees for one-on-one coaching sessions.

**Event Format**
- Breakfast and mentoring session
- Hosted at a local school
- Energetic networking expo

**Audience Profile**
Between 150 and 250 attendees made up of previous Women in Business attendees and winners, students, women business professionals.

**Event Date:** Week of April 7th
Women in Business Awards

Triangle Business Journal’s Women in Business awards remains the “gold standard” for recognition of female talent across the region. With over 400 alumni still casting their many talents across the Triangle, the Women in Biz award has created a community of committed women who continue to contribute much to business growth and stability in the region.

Each year, 25 women and one Lifetime Achievement award winner will grace the stage in front of their colleagues, friends and family as TBJ shines the spotlight on their achievements. The connections through the years are contagious, as alumni return to honor the new “Class”, and the aspirational mark their calendars to seek mentors and new networks.

Event Format
» Women In Business - Plated luncheon in large venue
» Energetic networking expo prior to awards luncheon
» VIP reception for winners, guests and sponsors prior to luncheon on site

Audience Profile
Between 300 and 350 attendees made up of alumni, colleagues of winners, friends and family. Nominations begin immediately after each year’s event, so attendance is driven early and often for this flagship TBJ celebration.

Event Date: Week of April 14th
Residential Real Estate Awards

An engaged panel discussion and awards celebration honoring the top residential real estate agents, developers and real estate companies.

**Event Format**
- Plated lunch and awards presentation
- Panel discussion around topical state of residential real estate

**Audience Profile**
Residential Real Estate Awards typically draws between 180 and 200 guests. Attendance is composed of winners and their guests; vertical vendor groups interested in networking with winners (such as subcontractors, contractors, architects and the financial sector) along with the sponsored panelists and their staff.

**Event Date:** Week of April 28th
Life Sciences Awards

The TBJ Life Sciences Awards tap directly into the robust growth of the life sciences sector in the region as it recognizes both individuals and research organizations that are breaking ground in this field.

There will be no better time to align your organization with this dynamic growth market. The sponsors of this event will certainly be held in high esteem for their insight and support of the inspirational work going on right here in the Triangle.

**Event Format**

- Plated luncheon and awards presentation
- Venue associated with, or in proximity to health research institutions

**Audience Profile**

Expected Attendance: 200 - 300. This event will be driven by both nominated companies and the organizations interested in access to their leadership from across the state, and perhaps southeast. Because the Triangle is in such a dominant position in this field, we know that much of the audience to be clinical, financial and investor based. C-suite executives who are interested in what the competition is developing will want to attend in person.

**Event Date:** May 5, 2017
CEO of the Year Awards

*Triangle Business Journal* is honored to be in its third year celebrating the accomplishments of those who lead on the executive front. This black tie event is one of our signature events and attendance always sells out.

Nominations for this coveted award are fierce, and the sustained sponsorship support is a direct reflection of that intensity.

**Audience Profile**

200 - 250 attendees. High level executives come to honor their leaders and enjoy an evening of celebration and networking. Exclusive group of business professionals get together to discuss their company’s highlights and goals for years to come.

Event Date: May 19, 2017
40 Under 40 Awards

Join Triangle Business Journal’s tradition of honoring the region’s most dynamic business leaders who happen to be under the age of 40. The roster of winners from years past and present include young professionals who have made deep contributions to both their businesses and the non-profit community.

Put your brand square in the middle of the Triangle’s future leaders by joining forces with TBJ as we recognize and nurture that talent – and the organizations they choose to align with.

**Event Format**
- Plated luncheon and awards presentation
- Partnership with Habitat for Humanity for pre-event 40 Under 40 “Build”

**Audience Profile**
Between 350 and 400 attendees, drawing on winners, past alumni, sectors with interest in networking with winners (financial/recruiters/insurance/legal/outdoor fitness & travel, etc).

---

**Event Date:** Week of June 23rd
CFO of the Year Awards

*Triangle Business Journal* is honored to celebrate the accomplishments of those who lead on the financial front, whether in challenging or optimistic economic times. Drawn from the ranks of the public, non-profit and private sector, these nominees are charged with delivering results that drop directly to the bottom line no matter what the forecast.

Nominations for this coveted award are fierce, and the sustained sponsorship support is a direct reflection of that intensity.

**Audience Profile**

200 - 250 attendees. C-suite executives come to honor their “right arms”, and recruiters and financial advisors fill the networking halls with their teams. In the Triangle, it is not unusual for the higher education institutions and leadership curriculum to send top decision-makers, and of course, the banks are always well-represented.

**Event Date:** Week of July 14
Tomorrow’s Real Estate

A combination of a mid-year update on the state of the real estate marketplace by a TBJ reporter and a lively panel discussion covering the nuances behind the numbers. Tomorrow’s Real Estate is THE destination for real estate pros who want to know trends and projections for the rest of the year.

**Event Format**
- Panel discussion moderated by a TBJ reporter
- Breakfast and plenty of coffee

**Audience Profile**
150 - 200 attendees. Top performers in the real estate sector and anyone who wants access to them, including financial management leadership, legal services and both commercial and residential support services groups.

**Event Date:** Week of July 28th
C-Suite Awards

This first-time event honors and recognizes the contributions of chief officers in the Triangle’s business community. This event highlights those executives who have done an outstanding job in the following roles: CEO, COO, CTO or CIO and CFO. All honorees are recognized on stage, with one winner named in each category.

Event Format
- Plated awards luncheon
- Networking expo prior to luncheon

Audience Profile
Between 150-200. Audience is composed of corporate counsel; information technology professionals; marketing professionals; HR leadership; recruiters; winners; their peers; their vendors.

Event Date: Week of August 11th
Leaders in Diversity

Triangle Business Journal will recognize the accomplishments of Triangle businesses, individuals and non-profits as they strive to reflect the rich tapestry of our community.

Nomination criteria includes such things as demonstrated respect or inclusive treatment of others, advocacy for underrepresented groups, and multicultural marketing.

This is the fifth year Leaders in Diversity is a part of the TBJ events roster. This event includes a Lifetime Achievement Award to recognize career-long compassion and commitment to diversity in the workplace.

Event Format
» Luncheon Awards

Audience Profile
150-200 attendees. A wide variety of Triangle companies, senior leadership, HR leaders and government leaders who are committed to diversity in the workplace.

Event Date: Week of September 8th
Best Places to Work

One of Triangle Business Journal’s liveliest events, Best Places to Work is one of the most sought-after business awards in the Triangle. As much a team-building event as an awards ceremony, Best Places combines rigorous judging criteria with a reputation for boisterous fun on the day the awards are celebrated.

The Best Places to Work national organization receives scores of nominations online, and determines each year’s roster of winners with confidentiality and credibility, working for months to mine mountains of data before announcing the final decisions.

**Event Format**

» Luncheon and awards presentation

**Audience Profile**

Teams from a wide variety of Triangle companies; senior leadership; HR leaders; marketing firms make up an audience that averages 450-500.

**Event Date:** Week of September 22nd
The Healthiest Employers Awards is quickly becoming one of Triangle Business Journal’s fastest growing events. The lively luncheon reflects the energy and momentum in the wellness movement across the Triangle’s corporate community.

Judged by the national Healthiest Employers organization, the top 20 winners are first announced by TBJ’s editorial team, with an exciting countdown “reveal” of the numerical rankings at the event itself. Already a list many companies aspire to be on, Healthiest Employers has become a badge of honor for companies large and small.

**Event Format**
» Plated luncheon
» Morning expo prior to the luncheon

**Audience Profile**
200-250. Audience composition includes winners and their teams, human resource leaders, recruiting firms, the clinical community and health insurance companies.

**Event Date:** Week of October 6th
Triangle Business Journal's Fast 50 Awards is the ultimate combination of tradition and entrepreneurial excitement. Recognizing only companies with proven track records of sustained growth over a three-year period, this glamorous fall evening has become the “destination” event for the Triangle business community.

Entries are audited by PriceWaterhouseCoopers in an extremely confidential process shielded from even Triangle Business Journal’s senior editorial team. When the results of the Top 50 companies are finally posted, there is still the wait for the rankings of that list – which happens in the form of an exciting countdown from #50 to #1 the evening of the event.

**Event Format**
- Semi-formal dinner and awards presentation
- Multimedia presentation of winners
- VIP winner and sponsor reception prior to the event

**Audience Profile**
400 - 500 attendees. Audience includes the Triangle’s most senior C-suite executives, along with elected officials; economic development executives; entrepreneurs; recruiters and corporate teams and investors

**Event Date:** November 9, 2017
Family Business Awards

Triangle Business Journal is pleased to announce our second annual Family Business Awards honoring family-owned as well as closely held businesses in the Triangle for overall excellence, innovation, ethics, philanthropy and contribution to the strength of the region.

**Event Format**
- Semi-formal dinner and awards presentation
- Multimedia presentation of winners
- VIP winner and sponsor reception prior to the event

**Audience Profile**
200 to 250 attendees. Audience includes the Triangle’s most senior C-suite executives, along with elected officials; economic development executives; entrepreneurs; recruiters and corporate teams and investors

**Event Date:** Week of December 8th
Power Breakfast
(Quarterly Event)

Power Breakfast has rapidly become Priority #1 on the calendars of the Triangle’s business elite. With speakers like Charles Swoboda, John Sklvara and Ann Goodnight, this quarterly series continues to draw the region’s power brokers. Getting beyond the traditional presentational format, Power Breakfast audiences have the unique opportunity to hear directly from the speakers combined with the rare access for Q&A for the majority of the two-hour format.

Event Format
» Buffet breakfast
» Member of the Editorial team moderates the Q&A session following brief remarks by the Power Breakfast speaker.

Audience Profile
C-level executives

Event Dates:
• Q1: March 2017
• Q2: June 2017
• Q3: August 2017
• Q4: November 2017
On the Road with TBJ
(Series of 3 Events)

A unique event that brings the economic experts and the stakeholders together for an honest discussion about economic development.

Hear from 3 counties just miles away from Research Triangle Park that are rich with tradition, culture, resources and most important: talent. Learn about the area, its employer base, labor force and the opportunities.

Come and mingle with all of the important business, government and municipal executives under one roof. Learn about incentives, learn about the competitive landscape and above all, learn about how you can get an upper hand in this uber-competitive landscape.

Event Format
» Buffet breakfast
» Member of the Editorial team moderates the Q&A session following brief remarks about the state of economic development in the region.

Audience Profile
C-level executives from all over the Triangle come to hear about rural North Carolina markets expansion and growth potential.

Event Dates:
• February 2017 | Sanford
• June 2017 | Rocky Mount
• September 2017 | Creedmoor
Your participation makes these events a huge success!
Title Sponsorship

Sponsorship Includes:
» Logo placement in all print and electronic event collateral
» Hyperlink from the event registration page at www.trianglebusinessjournal.com
» Pre-event sponsorship leveraging meeting
» Recognition from podium as a sponsor
» Logo in rolling multi-media display at the event, if available
» Logo on all event signage
» Logo on “Thank You” ad in TBJ following the event
» Electronic list of event attendees and award winners
» Display table at the expo in a premier location if applicable
» Premier position and exposure on event micro site
» Sponsor name incorporated in official event logo and awards
» Option to place collateral at event
» Ability to provide gift to attendees
» Category Exclusivity within core SIC (available only with Triangle Business Journal approval, unavailable with the following events: CIO, Corporate Counsel, Life Science, and Healthiest Employers)
» Event speaking opportunity for 2 minutes or optional keynote address (based on TBJ approval)
» Logo on cover of Special Section
» Full page, four color advertisement in Special Section with Premium ad placement (inside cover or back cover)
» 200,000 impressions on TBJ website
» 1/2 page Word from Sponsor letter (400 words) with logo and photo in Special Section
» 1 Sponsor Table of 10 with premium reserved seating and table signage at the event
» 1 seat at the Publisher’s Table
» Stage presence opportunity
» Opportunity to meet with the Director of Advertising and Publisher to review alternatives to standard benefits listed
» 60 day renewal/right of refusal
» 2 annual subscriptions at Triangle Business Journal
» Full Page Ad in Book of Lists

Custom Enhancements (select 6):
» Publisher introductions to C-level executives at event
» Conduct research by providing two questions in post-event survey
» Business development training on sponsorship activation (pre-event)
» Custom step-and-repeat
» “Where are they Now” post-event sponsored section (only applicable to award events)
» VIP dinner with Publisher and select finalists or panelists of your choice (depending on availability) (additional $2K)
» Ability to provide 30-second commercial video at the event (if applicable to event venue)
» Opportunity to participate in registration process by providing company representatives as greeters
» Display table to promote your products/services at the event
» Corporate Subscription Portal

AVAILABILITY
One title sponsorship is available per event.

INVESTMENT
Sponsorship cost is $23,000.

FREQUENCY
1 EVENT: $23,000
2+ EVENTS: $20,000

YOU GET AN AD
All ad sizes and specs can be downloaded at TriangleBusinessJournal.com
Advertisements for special sections are due Friday, 2 weeks prior to publication.

WE NEED YOUR LOGO
Your logo should be sent as soon as you sign on for the sponsorship.
Preferred file type: Vector .eps (if not available, please send .ai, .pdf, .psd or a high-resolution .jpg; logos saved from the internet are not accepted.)
Presenting Sponsorship

**Sponsorship Includes:**
- Logo placement in all print and electronic event collateral
- Industry exclusive up to two competitors
- Hyperlink from the event registration page at www.trianglebusinessjournal.com
- Pre-event sponsorship leveraging meeting
- Recognition from podium as a sponsor
- Logo in rolling multi-media display at the event, if available
- Logo on all event signage
- Logo on award (applicable for award events only)
- Logo on “Thank You” ad in TBJ following the event
- Electronic list of event attendees and award winners
- Display table at the expo in a premier location if applicable
- Premier position and exposure on event micro site
- Event speaking opportunity
- 1/2 page, four color advertisement in Special Section with Premium ad placement
- 130,000 impressions on TBJ website
- Logo on cover of Special Section
- 1/4 page Word from Sponsor letter (200 words) with logo and photo in Special Section
- 1 Sponsor Table of 10 with premium reserved seating and table signage at the event
- 30 day renewal/right of refusal
- 2 annual subscriptions at Triangle Business Journal
- Book of Lists presence at Triangle Business Journal Partner rate
- 1/2 page ad in the Book of Lists
- Morning Edition

**Custom Enhancements (select 4):**
- Publisher introductions to C-level executives at event
- Conduct research by providing two questions in post-event survey
- Business development training on sponsorship activation (pre-event)
- Custom step-and-repeat
- “Where are they Now” post-event sponsored section (only applicable to award events)
- VIP dinner with Publisher and select finalists or panelists of your choice (depending on availability) (addional $2K)
- Ability to provide 30-second commercial video at the event (if applicable to event venue)
- Opportunity to participate in registration process by providing company representatives as greeters
- Display table to promote your products/services at the event
- Corporate Subscription Portal

**AVAILABILITY**
One platinum sponsorship is available per event.

**INVESTMENT**
Sponsorship cost is $17,500.

**FREQUENCY**
- 1 EVENT: $17,500
- 2–5 EVENTS: $16,500
- 6+ EVENT: $15,000

**YOU GET AN AD**
All ad sizes and specs can be downloaded at TriangleBusinessJournal.com
Advertisements for special sections are due Friday, 2 weeks prior to publication.

**WE NEED YOUR LOGO**
Your logo should be sent as soon as you sign on for the sponsorship.
Preferred file type: Vector .eps (if not available, please send .ai, .pdf, .psd or a high-resolution .jpg; logos saved from the internet are not accepted.)
Corporate Sponsorship

**Sponsorship Includes:**

» Attendee list (excluding email addresses)
» First right of refusal within 60 days of the event
» Logo on all promotional collateral (Promotional collateral is defined as invitation, advertisements – printed and digital, nomination website, registration website, event signage and rolling media if applicable.)
» 10 tickets to the event. Preferred table placement and table sign (if applicable)
» Opportunity to place collateral item at table or seat during the event
» Ability to provide gifts to finalists/honorees
» Logo recognition in the “Thank You” advertisement after the event
» Pre-event planning meeting (10 weeks prior to event)
» One 1/4 page, 4-color print ad in the Special Report section of Triangle Business Journal
» One 1/4 page, 4-color print ad in the Book of Lists
» Word from Sponsor letter (up to 100 words) with photo in Special Report section of the Triangle Business Journal published the week of the event
» Special Report cover logo placement
» Digital presence: Email or website for 1 month

**Custom Enhancements (select 2):**

» Business development training on sponsorship activation (pre-event)
» 2 tickets to pre-event VIP reception hosted by the Triangle Business Journal applicable
» VIP dinner with Publisher and select finalists or panelists of your choice (depending on availability)(additional $2K)
» Opportunity to participate in registration process by providing company representatives as greeters
» Display table to promote your products/services at the event
» Sponsor Valet or Centerpiece at the event
» 2 subscriptions to the Triangle Business Journal including 2018 Book of Lists

**AVAILABILITY**

One platinum sponsorship is available per event.

**INVESTMENT**

Sponsorship cost is $9,000

**FREQUENCY**

<table>
<thead>
<tr>
<th>EVENTS</th>
<th>INVESTMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 EVENT</td>
<td>$9,000</td>
</tr>
<tr>
<td>2–5 EVENTS</td>
<td>$8,000</td>
</tr>
<tr>
<td>6+ EVENT</td>
<td>$7,000</td>
</tr>
</tbody>
</table>

**YOU GET AN AD**

All ad sizes and specs can be downloaded at TriangleBusinessJournal.com

Advertisements for special sections are due Friday, 2 weeks prior to publication.

**WE NEED YOUR LOGO**

Your logo should be sent as soon as you sign on for the sponsorship.

Preferred file type: Vector .eps (if not available, please send .ai, .pdf, .psd or a high-resolution .jpg; logos saved from the internet are not accepted.)
Welcome/Afterglow Sponsorship

**Sponsorship Includes:**
- Remarks from podium at the reception
- Logo placement in all print and electronic event collateral
- Hyperlink from the event registration page at www.trianglebusinessjournal.com
- Pre-event sponsorship leveraging meeting
- Recognition from podium as a sponsor
- Logo in rolling multi-media display at the event, if available
- Logo on all event signage
- Logo on “Thank You” ad in TBJ following the event
- Electronic list of event attendees and award winners
- Display table at the expo in a premier location if applicable
- 30 day renewal/right of refusal
- 1 Sponsor Table of 10 with premium reserved seating and table signage at the event
- 1/4 page, four color advertisement in Special Section
- 1 week Afternoon Edition email campaign
- 1 annual subscription to Triangle Business Journal
- Logo on Glassware – afterglow
- Logo on Badges – welcome

**AVAILABILITY**
One welcome/afterglow sponsorship is available per event.

**INVESTMENT**
Sponsorship cost is $9,000.

**FREQUENCY**

<table>
<thead>
<tr>
<th>Event Frequency</th>
<th>Investment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 EVENT</td>
<td>$9,000</td>
</tr>
<tr>
<td>2–5 EVENTS</td>
<td>$8,000</td>
</tr>
<tr>
<td>6+ EVENT</td>
<td>$7,000</td>
</tr>
</tbody>
</table>

**WE NEED YOUR LOGO**
Your logo should be sent as soon as you sign on for the sponsorship.

Preferred file type: Vector .eps (if not available, please send .ai, .pdf, .psd or a high-resolution .jpg; logos saved from the internet are not accepted.)
TweetWall Sponsorship

**Sponsorship Includes:**

- Attendee list (excluding e-mail addresses)
- Logo on all promotional collateral (Promotional collateral is defined as invitation, advertisements – printing and digital, nomination website, registration website, event signage and rolling media if applicable.)
- Sponsor the Tweetwall during the awards program
- Sponsor could place pop-up banners in background creating infinite exposure
- 8 tickets to the event
- Logo in event presentation and on cover of Special Report
- Recognition from podium
- Logo on special “Thank You” ad following the event

**AVAILABILITY**

One TweetWall sponsorship is available per event.

**INVESTMENT**

Sponsorship cost is $5,000.

**FREQUENCY**

1 EVENT: $5,000  
2–5 EVENTS: $4,000  
6+ EVENT: $3,000

**WE NEED YOUR LOGO**

Your logo should be sent as soon as you sign on for the sponsorship.  
Preferred file type: Vector .eps (if not available, please send .ai, .pdf, .psd or a high-resolution .jpg; logos saved from the internet are not accepted.)
Photobooth Sponsorship

Sponsorship Includes:

» Hyperlink from the event registration page at www.trianglebusinessjournal.com
» Logo placement in all print and electronic event collateral
» Pre-event sponsorship leveraging meeting
» Recognition from podium as a sponsor
» Logo in rolling multi-media display at the event, if available
» Logo on all event signage
» Logo on “Thank You” ad in TBJ following the event
» Celebrity “Step and Repeat” Photo Wall with your logo and TBJ’s logo
» Photos from Celebrity Wall will be used for the TBJ slideshow on the website
» 1 Sponsor Table of 10 with premium reserved seating and table signage at the event
» 30 day renewal/right of refusal
» Electronic list of event attendees and award winners
» Sponsor has the opportunity to escort winners to have their photo taken at the celebrity wall
» 1/4 page, four color advertisement in Special Section
» 1 annual subscription to Triangle Business Journal
» Digital Morning Edition
» Logo on printouts at the event (see image for example)
» All pictures taken at the event are tweeted out by TapSnap

AVAILABILITY
One photobooth sponsorship is available per event.

INVESTMENT
Sponsorship cost is $5,000.

FREQUENCY
1 EVENT: $5,000
2–5 EVENTS: $4,000
6+ EVENT: $3,000

WE NEED YOUR LOGO
Your logo should be sent as soon as you sign on for the sponsorship.
Preferred file type: Vector .eps (if not available, please send .ai, .pdf, .psd or a high-resolution .jpg; logos saved from the internet are not accepted.)
**Sponsorship Includes:**

- Hyperlink from the event registration page at www.trianglebusinessjournal.com
- Logo placement in all print and electronic event collateral
- Pre-event sponsorship leveraging meeting
- Recognition from podium as a sponsor
- Logo in rolling multi-media display at the event, if available
- Logo on all event signage
- Logo on directional signage to the event
- Logo on parking pass distributed to all guests, if available
- Logo on “Thank You” ad in TBJ following the event
- 1 Sponsor Table of 10 with premium reserved seating and table signage at the event
- 30 day renewal/right of refusal
- Electronic list of event attendees and award winners
- 1/4 page, four color advertisement in Special Section
- 1 annual subscription to Triangle Business Journal
- Digital Morning Edition
- Logo on printouts at the event (see image for example)
- Ability to leave marketing materials in each vehicle

**AVAILABILITY**

One valet and parking sponsorship is available per event.

**INVESTMENT**

Sponsorship cost is $5,000.

**FREQUENCY**

<table>
<thead>
<tr>
<th>EVENTS</th>
<th>INVESTMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 EVENT</td>
<td>$5,000</td>
</tr>
<tr>
<td>2–5 EVENTS</td>
<td>$4,000</td>
</tr>
<tr>
<td>6+ EVENT</td>
<td>$3,000</td>
</tr>
</tbody>
</table>

**WE NEED YOUR LOGO**

Your logo should be sent as soon as you sign on for the sponsorship.

Preferred file type: Vector .eps (if not available, please send .ai, .pdf, .psd or a high-resolution .jpg; logos saved from the internet are not accepted.)
Power Breakfast Sponsorship

**Sponsorship Includes:**
- Logo placement in all print and electronic event collateral
- Hyperlink from the event registration page at www.trianglebusinessjournal.com
- Pre-event sponsorship leveraging meeting
- Recognition from podium as a sponsor
- Logo in rolling multi-media display at the event, if available
- Logo on all event signage
- Logo on “Thank You” ad in TBJ following the event
- Electronic list of event attendees
- Display table at the expo in a premier location if applicable
- Premier position and exposure on event micro site
- 4 tickets to the event
- 30 day renewal/right of refusal

**Series Sponsorship Also Includes:**
- Remarks from podium at event

**AVAILABILITY**
Sponsorships available for all TBJ Power Breakfasts

**FREQUENCY**

<table>
<thead>
<tr>
<th>SERIES TITLE</th>
<th>$5,000</th>
</tr>
</thead>
<tbody>
<tr>
<td>SERIES SUPPORTING</td>
<td>$4,000</td>
</tr>
</tbody>
</table>

**WE NEED YOUR LOGO**

Your logo should be sent as soon as you sign on for the sponsorship.

Preferred file type: Vector .eps (If not available, please send .ai, .pdf, .psd or a high-resolution .jpg; logos saved from the internet are not accepted.)
**Roundtable Includes:**
- A seat at the discussion
- A profile in the special section with headshot and company logo
- Input as to the topic and Q&A of discussion
- 1/4 page 4-color ad in printed special section
- Company logo on the front page of the printed section
- PDF of the printed section provided to use for additional marketing
- Additional $1,000 for online special section

**Live Panel Discussion Includes:**
- LIVE Event (breakfast or lunch)
- May provide suggestions for venue location
- A seat at the discussion
- A profile in the special section with headshot and company logo
- Input as to the topic and Q&A of discussion
- 1/2 page 4-color ad in printed special section
- Company logo on the front page of the printed section
- PDF of the printed section provided to use for additional marketing
- Additional $1,000 for online special section

**BUILD YOUR OWN EVENT**

**Business Panels**

Title Sponsors receive full ownership of the program and development of the content

**INVESTMENT**

- $3,500 for Roundtable
- $6,500 for Live Panel Discussion

**PICK THE PANELISTS**

3 like-minded experts must buy-in. TBJ can take requests as to whom you would like to join the discussion and make those calls on your behalf. You may also bring on board any connections of your own.
Questions?

We are happy to answer any questions you have about the information in this packet. If you do not have an assigned Account Executive, please use the contact information below. Happy Sponsoring!

**Sponsorship Inquiries**

Nicholas Boetcher  
Director of Advertising  
919-327-1032  
nboetcher@bizjournals.com

**Event Inquiries**

Caroline Saleeby  
919-327-1002  
csaleeby@bizjournals.com

**Resources**

» Events calendar: TBJevents.com  
» Nominations: TBJnominations.com  
» Sponsorship & advertising information: TriangleBusinessJournal.com
Contact Us
Find more information at TriangleBusinessJournal.com

SALES TEAM
DIRECTOR OF ADVERTISING
Nicholas Boetcher  919-327-1032 (office)   nboetcher@bizjournals.com
919-236-9390 (cell)

ACCOUNT EXECUTIVES
Heather Rodgers  919-327-1027  hrodgers@bizjournals.com
John Kerr  919-327-1013  jkerr@bizjournals.com
Nicole Panor  919-327-1010  ngoodrich@bizjournals.com